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Introduction
VR CNC Milling is a Windows based software package allowing full editing and control of 
CNC fi les, either offl ine (away from the CNC machine) or online (controlling the operation of 
a CNC machine).

The VR Milling V5 software contains detailed help fi les including tutorials and animations. 
Access these by going to Help on the menu. See the appendix in this document for more 
details

As you move through the different areas of the software you will see this icon  if you 
need help about the area of software you are in, click this icon to see context sensitive help.

To start the VR Milling 
software double-click the VR 
Milling V5 shortcut icon (if 
available) on your desktop.

If the shortcut is not 
available, click “Start” on 
your “Windows” Start button 
followed by the “Programs” 
option, the program group 
“Denford” and fi nally the “VR 
Milling V5” icon.

Step1 - Start the VR Milling V5 software
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Step 2 - Confi gure the software for the machine
Ensure that the software is confi gured for the machine you are going to use.

The text at the end of the main title-bar indicates the type of Denford CNC machine that 
you are currently able to control with the software. In the example screenshot below, the 
“MICROROUTER PRO” text indicates that a Denford Microrouter Pro can be controlled by 
the software.

To change the name of the Denford CNC machine that can be controlled by the software:

1. Click the “Setup” menu and choose “Select Machine ...” 

2. Highlight the name of the machine required and click [OK]

3. You may need to look at the CE identifi cation panel on your Denford CNC 
machine to identify the name of your CNC machine

Legacy machines:These are older machines that are no longer in production but are 
still compatible with VR CNC Milling V5 software. Click the [Legacy Machines] button 
to list these types of machine.
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Step 3 - Load your CNC fi le.
Click the “File” menu and select the “Open” option.

Browse to the drive and folder containing your CNC fi le – look for fi les with the extension 
letters “.fnc” then [Open] the fi le.

The contents of your CNC fi le will be displayed in the Editor window. As the name suggests, 
CNC fi les can be further edited here or you could even write one from scratch.

By using the 'drop-down' menu labelled 'Files of Type:' two alternative fi le types can 
be opened, these are: Gerber fi les for creating PCB's and DXF/DWG fi les for creating 
programs from 2D line drawing data.

Loading alternative fi le types

If either of these fi le types are opened a simple wizard guides the user through a series of 
steps to create a CNC fi le to create the component. See the help fi les within the software or 
the appendix in this document for more information.
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Step 4 - Confi gure the tooling
Click the [Tool and Offset Editor Window] button and the window will open.

Click the “Tooling Data” tab.

Each tool used in your CNC program must be defi ned here, failing to do so will cause an 
error message when running a simulation.
The length and diameter of the tools shown in the VR, 3D and 2D simulations are taken 
from this table, for the simulations to be accurate the correct tool sizes need to be defi ned.

In this example we are going to load a 1⁄4” Ball Nose cutter, which is a versatile tool supplied 
with the Denford range of CNC Routers.

Click the [Tool and Offset Editor Window] button again to close the Window down.

Adding a new tool to the list
A new tool can be added to the list by:
a) Selecting a blank tool in the list, then 
entering all the values for that tool in the right 
hand section of the window. Note: a new 
tool created here can be added to the ‘Tool 
Library’ by clicking the  button pictured or by 
right clicking on the tool and selecting “Save 
tool to Library” from the pop up menu.
b) Selecting one of the pre-defi ned tools in 
the ‘Tool Library’. This can be done by clicking 
the button pictured or by right clicking on a 
blank tool and selecting “Insert Library Tool” 
from the pop up menu.

 “Save tool to Library”

  “Insert Library Tool” 

To add the 1⁄4” Ball Nose cutter, 
highlight tool position 1, then click 
the  “Insert Library Tool” button. 

Choose the tool from the “Library 
Tool Selector”, click [OK]. The 1⁄4” 
Ball Nose cutter should appear in 
tool position number 1.
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Step 5 - Running a simulation.
Click the 2D/3D Simulation Button and the “Simulation” window will open. Click the Play 
button on the fi le control toolbar to begin the simulation.

Click the “Turbo” button to speed up the simulation, the graphics will be generated 
periodically, not “on the fl y”.

Left click (hold) and move the mouse to rotate the view. Right click (Hold), and move the 
mouse to zoom the view. Hold both the left and right mouse buttons to move/pan the view.

Under the “Simulation” menu choose “Billet Materials …” to change the appearance of the 
simulation including the material with which the model is rendered.

Use the buttons at the top of the simulation window to toggle between a 2D and a 3D view, 
to display the toolpaths, to hide and show the billet, and to play machining sounds among 
other things.

Most CNC fi les will have the datum position (0,0,0) in the near, top, left corner of the billet, 
however with programs like Denford QuickCAM 3D and QuickCAM Pro it is possible to shift 
the datum position. 

To get an accurate simulation the datum can also be shifted in the simulation.

This option can be found in the “Simulation | Datum Position...” menu.

Select a position on the block to defi ne the datum used in the CNC program.
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Step 6 – Connect to, and Home the CNC machine

To connect to the CNC machine, left click the [Machine] 
button. Depending upon which machine you are using, a 
progress bar may appear, allow this to reach 100% and a 
connection will be established between the machine and 
the PC.

At this point ensure that the cable is connected from the 
PC to the Machine (either RS232 or USB) and that the 
machine is switched on.

Once a connection has been 
successfully established, the machine 
“Control Panel” window will appear. 
At the moment, only the “Home” tab is 
available. Click the [Home All] button to 
home all three machine axis.

After Homing, the “Jog, Auto and MDI” 
tabs become available, as shown right.
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Step 7 - Move the machine head and fi t the cutting tool.

The position of the machine head (the cutting tool) can 
be manually controlled using Jog mode. In the “Control 
Panel” window, click the “Jog” tab to select Jog mode.

To change the position of the machine head quickly, 
click the [Jog] button until a straight arrow is displayed, 
signifying ‘Jog Continuous’ mode.

Click and drag the Jog Feed control knob to the top of 
the scale. The feedrate value is shown in the readout 
below the control knob.

The four cursor (arrow) keys, and the [Page Up] and 
[Page Down] keys on the keyboard, are used to control 
the X, Y and Z axes. Press and hold the appropriate key 
to move the required axis.

"Jog Continous"

"Jog Step"

To change the position of the machine head incrementally, 
click the Jog button until the image changes from a single 
arrow to three small, stepped arrows, signifying Jog Step 
Mode.

Click and drag the Jog Feed control knob to adjust the 
increment. When you press the cursor keys the cutter will 
move by the amount set.

Jog the machine head to an appropriate position, then, fi t 
the cutting tool. The procedure for this will vary depending 
on the machine type. See the machine manual for more 
detailed information on this procedure. 

For the Denford Microuter, Microrouter Pro and 
Microrouter Compact you may fi nd it easier to remove the 
motor to change the tool.
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Step 8 - Fit the material in the machine.
There are various methods for holding material in the CNC machines, the one you choose 
will depend on the type of job you are undertaking and the machine you are using.

On the Denford Microrouter/Microrouter Pro a vacuum pump is fi tted to the machine and 
using a vacuum table, the material is literally “sucked” to the vacuum table. This is a very 
simple and effective method of securing the material. If you are cutting all the way through 
the material however you may want to protect the vacuum table from becoming damaged. 

Special jigs or fi xtures are available for the “F1 team in schools” competition and there is a 
“4th axis” fi xture available, which rotates the material as it is cut, enabling production of fully 
3D models in a single operation.

Parallel clamps are supplied with the Denford Microrouter/Microrouter Pro which enables a 
piece of material to be “sandwiched” between the clamps which is then elevated from the 
base of the machine. This would be a suitable method of securing material when it is to be 
cut all the way through.
The Microrouter Compact has a “T slot” table which allows for more traditional clamping 
arrangements. The Microrouter Compact is supplied with an easy to use, lever-operated, 
clamping kit.
Milling machines such as the Denford Novamill, Triton and Triac have options including a 
“Mitee-Bite” clamping kit which is quick and easy to use.
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Step 9 – Set the work offsets
What are offsets?
Offsets are the distances the cutter needs to travel, 
from its 'Home' position to the point from which the 
program starts in X Y & Z.
Usually the point at which the program starts 
(the datum) is the upper, front, left corner of the 
material although some software including Denford 
QuickCAM 3D and QuickCAM Pro allow the user to 
specify a different datum position. 

Create a new work offset
It is possible to store a number of offsets and swap between them for 
different jobs.  Use this facility to create a new offset and add it to the 
list. 
•Click the "New work offset" button. 
•Click on the ‘blank’ offset that has been added to the list to select it. 
•Type in a description for your new offset. 

To delete an offset you can either:
•Select the offset and click the “Delete current selection”  button
•Right click on the offset description and select “Delete Offset” from the 
pop-up menu. 

"New work offsets"

"Delete current selection"

Click the button to show the “Tool and Offset Editor” 
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Make sure the Offset you have just created is Active. It is possible to have a number of 
Offsets stored and change from one to another. The machine will use the Offset which is 
currently active. To activate an Offset, select it in the list and either, click the Activate button 
or Right Click on the Offset in the list and choose Activate from the menu. The Active Offset 
is highlighted in green.
Using the techniques described in Step 7, Jog the cutter until you are touching the material 
in the datum position. For most jobs it is suffi cient to visually sight the cutter over the X and 
Y axis and then incrementally jog the cutter until it is touching the material surface in Z.

When the cutter is in position click the  to set all 3 axes at once.When the cutter is in position click the  

1. The axes can be set individually by moving the 
cutter to the correct positions and setting the 
offsets one at a time.

2. To set the offsets more accurately, touch the cutter 
against the side of the material and use the “datum 
offset button” at the right of each offset value to 
offset the datum value. This is usually used by 
touching the cutter up to the side of the material, 
and using the cutter radius, offset the datum value 
so that the center of the cutter is exactly over the 
edge of the material. It is the radius of the currently 
active tool which appears by default as the value in 
the “Offset Datum Position” window, this value can 
be changed.

When the offsets have been set there will be three values assigned to the “Test” offset. This 
is the distance from the machines “Home position” to the position the cutter is currently in. 

Activate the offset
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Step 10 – Verify the Work Offsets and the Program.
Before we run the program we can use the “Program Information” function to verify that the 
program will be completed without errors. 

There is a problem with the above example because the billet is positioned too far over to 
the right. We need to re-position the billet nearer to the left hand corner of the machine table 
and redefi ne the offsets.
The X offset value must be changed in the tools and offsets editor. 
To close the window down click the “Program Information” button again.

A common error is when a program “Exceeds Limits”, this error occurs when part of the 
toolpath is outside of the CNC machines working envelope.

If an error is detected a window appears on the screen similar to the one shown below. 

This message appears if the 
CNC program is attempting 
to move to a position 
outside the cutting area of 
the machine. The window 
displays the fi rst line in the 
CNC program that contains 
the ‘over travel’ movement 
and by how much. 
There are basically two 
reasons why this could 
happen:
a) The workpiece and 
or tool length offsets 
are inappropriate for the 
program. 
b) The overall size of the 
component you are trying 
to machine is too large for 
the CNC machine working 
envelope
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Step 11 – Run the Program.
The program is now ready to be run. To run the 
machine you must click on the 'Auto' tab. 

The program must be run from the beginning, 
to ensure this is the case click the Stop button, 
followed by Rewind and fi nally click the Start 
button.

The program will begin to run. A message may 
appear asking you to change to Tool Number 
*. Check you have the correct tool and click 
[OK]. The spindle will start and the program 
will begin. 

At the bottom of the Auto tab are the Feed 
rate Override and Spindle speed Override 
controls. If the machine you are using is fi tted 
with Potentiometers it is these which are used 
to override the Feed rate and Spindle speed. If 
not you can affect these using the mouse.

Tip: to gain more control, the feed rate can be reduced to 
gradually feed in the cutter until you are happy and then 
increased.

Turbo Mode

Click the [Turbo Mode] button to switch 
Turbo Mode on. This can be done at 
any time, even when the program is 
running. The ‘turbo mode’ feature has 
been developed to reduce the machining 
times of large 3D programs and complex 
2D programs. For larger programs E.G. 
more than 100 lines, turbo mode on will 
usually make the machine perform with a 
smoother motion. It is recommended that 
programs produced from 3D CAD/CAM 
software are run with turbo mode on.Spindle and Feedrate potentiometers
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Help Files and tutorials
The VR Milling V5 software contains detailed help fi les including tutorials and animations. 
Access these by going to Help on the menu. 

As you move through the different areas of the software you will see this icon:   if you 
need help about the area of software you are in, click this icon to see context sensitive help.

The full VR Milling V5 help fi les can 
be accessed by choosing Help > VR 
Milling from the main menu at the top 
of the screen.

There is also an option to view help 
fi les on CNC programming.

This help fi le covers the stages involved in producing the coded instructions, used by 
the CNC machine to make the component. These coded instructions are called the part 
program.
Each part program contains a number of different codes, the most important being the 
collection of G and M codes.
The helpfi le is divided into three main sections, each with their own list of topics:
1) Basic Programming
2) G Codes
3) M Codes
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Also found under the Help menu 
are various tutorials. The tutorials 
launch in a window next to the main 
VR Milling V5 window and guide 
the user step by step through the 
chosen topic. Topics include: Cutting 
a part with a single tool, Drawing 
(DXF/DWG) Import CAM tutorial, 
PCB manufacture, Setting up a New 
Tool and Simulating a Part using the 
VR Machine.

Tutorial 
window open 
next to the 
main VR 
Milling window

Many of the tutorials have [Do it now!] buttons which will automatically carry out the 
operation. The content of this guide is covered by the tutorials if you are having problems 
following these instructions or do not have access to this guide the tutorials should help you.
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Dxf/Dwg fi le import
VR CNC Milling has the facility to open 2D vector drawing data in dxf and dwg formats 
(version 5.10 onwards). When dxf or dwg fi les are opened in VR CNC Milling, a wizard is 
launched which guides the user through some simple steps in order to manufacture the fi le. 
The wizard uses central machine tooling and material libraries within VR Milling to ensure 
only the tools you have available can be used and that suitable speeds and feeds are 
automatically generated.
The following tutorial gives an explanation of the steps involved in manufacturing a dxf or 
dwg drawing using Denford VR CNC Milling.

Creating a Dxf/Dwg fi le
Most CAD packages will create a dxf fi le and many good graphics packages will also create 
them. AutoCAD, ProDesktop, Corel Draw and Techsoft Design Tools are among a few of 
the packages capable of creating the dxf or dwg fi le format. The process of creating the dxf 
or dwg fi le will vary from package to package but is usually found under the File | Export 
menu option.
It will usually be necessary to select 
the type of fi le you want to export 
from a drop-down menu. This is 
shown in the image, right, taken from 
the export menu in Corel Draw. 
See the help fi les in your CAD 
software for more information.

The Dxf/Dwg fi le import wizard within VR CNC Milling does not enable the user to edit the 
fi le in any way. The fi le cannot be scaled within the wizard. The user must therefore edit and 
size the fi le correctly in the design software before exporting the fi nished Dxf/Dwg fi le. 

To apply some of the machining plans available in the wizard the vectors must be closed 
i.e: there should be no gaps in the shapes within the design. If you want to remove all the 
material within an area, the boundary around the area must be closed. If not the following 
message will be displayed

Preparing the DXF/DWG fi le
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Load the Dxf/Dwg fi le
In the VR Milling V5 software click the “File” menu and select 
the “Open” option.

Browse to the drive and folder containing the Dxf/Dwg fi le that 
has been exported/saved from your CAD package.

You will need to click the drop-down menu labelled "Files of 
type" and choose "DXF and DWG Files (*.dxf. *.dwg)"

When you have located the DXF or DWG fi le you 
would like to manufacture click [Open].

You will then be prompted to choose a material to 
manufacture your design from.

Material Selection

By choosing a material from the list the 
spindle speed, feedrate and depth of cut 
will be predetermined.  You can add, edit 
and save material types within VR Milling 
V5.

To edit materials go to "Setup | Materials 
| Edit Materials..."

You will be prompted for a password, by 
default this is "denny".

Once you have chosen a material and clicked [OK] the main CAM wizard will be launched.
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Once a material has been chosen the Main CAM (Computer Aided Manufacturing) Wizard 
is launched and your Dxf fi le will be dispayed. The fi rst screen is called 'Layers'. DXF fi les 
can be exported with Layer information. Layers can be deselected so that only the required 
information can be seen. 

In the example left, the heart has 
been drawn on one layer. This 
means that the layers cannot be 
turned on and off. A typical use for 
layers is to put dimensioning on 
a separate layer, so that if further 
work is needed on the drawing, the 
dimensioning layer may be turned 
off to remove the “clutter” of the 
dimensioning.  In a similar way, if a 
Dxf drawing is to be cut, machined, 
or engraved, the dimensioning/
notes/border, or any unwanted 
information, may be “turned off” fi rst

In the example right, the different 
elements of the heart have been 
drawn on seperate layers and can 
be switched on or off. The holes 
have been drawn on their own 
layer and have been turned off.

Files can be exported from the CAD software in either Metric or Imperial units so an option 
is available to select the correct units. DXF and DWG fi les cannot be scaled or edited within 
the CAM Wizard, if the drawing needs to be scaled this must be done in the CAD software. 
However, if you fi nd that the drawing is smaller than you expect it to be, it may have been 
exported in imperial units, try clicking the 'Inch' radio button to see if this resolves the 
problem.

Input File Units
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Defi ne Billet
The Defi ne Billet screen allows the size of the billet (material) 
to be defi ned and the position of the drawing within the 
material to be determined.

The width, depth and height of the billet can be entered in 
the dialogue boxes.

Alternatively, the blue control handle can be dragged to 
determine the size of the billet.

With the 'Use Drawing Origin' box checked, the datum position is taken from the datum 
position in the CAD software used to create the drawing. 
If the box is unchecked the datum symbol on the screen can be dragged to replace the 
drawing origin (this effectively moves the material).
When the "Drawing Extents" check box is ticked, the [AutoSize] button will set the billet size 
to the extents of the drawing with no border around it. Clicking the [AutoSize] button with the 
drawing extents box unchecked will set the billet size with an equally spaced border around 
the drawing. The spacing amount is determined by the distance from the drawing origin to 
the nearest vector.
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Machining Plans
The machining plans screen is used to compile a list of strategies for machining the 
component. There are 6 different 'Plans' that can be applied, they are:
• Follow Cut - the centre of the cutter will follow the line. This tool is used normally for 
engraving.
• Inside Offset - This tool will create a tool path inside a Vector offset by the radius of the 
tool diameter. (a closed vector is required)
• Outside Offset - This tool will create a tool path outside a Vector offset by the radius of the 
tool diameter (a closed vector is required)
• Area Clearance - This plan removes the area of material enclosed by a vector but leaves 
any other selected vector islands intact. If the tool cannot fi t between two vectors it will 
remove only what is possible. The tool path created follows the outline of the vector shape 
(a closed vector is required)
• Raster Clearance - This plan does much the same as the Area Clearance plan but instead 
of following the contour of the shape the cutter path rasters in linear moves. The Raster 
toolpath is cut fi rst then an inside offset toolpath is generated to clean up all the edges of the 
shape. (a closed vector is required)
• Drill Cut - This plan will fi nd the centre of any circle included in the design. If different 
holes are to be drilled different depths then create multiple plans.

A list of plans can be 
compiled, plans can be 
reordered, turned on and 
off, edited and deleted using 
the buttons next to the list 
of plans.

The same plan can be used 
multiple times to create cuts 
of different depths

See the Help fi les in VR Milling V5.10 and above for more details on each machining plan. 
These can be found by accessing Help > Tutorials > Drawing Import CAM tutorial.

Click [Next >] to move to the next screen.
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Select “Check Output” and the tool-paths 
are simulated in order.
This allows you to check if the order of 
machining is correct before creating the 
code.
The tool diameter is shown.
Rapid moves are shown in Red while the 
cut path is shown in Blue. If the depth 
requires multiple passes these will also 
be shown.

Check Output and Post Process

In this example the outline of the heart 
shaped box was cut with the “Outside 
Offset Cut”
As the centreline of the cutter is close to 
the edge of the block the actual cutter 
diameter will break through the side of the 
block.
While this may be OK the cutter could hit 
a clamp so a Red warning message is 
displayed.
This will not prevent the fi le being Post 
Processed but is displayed as a warning.

Select “Post Process”
The G&M code will be created and will 
open in the machine editor.
The screen shown is has the program 
opened in the full editor with colour 
formatting on.
The fi le can now be manufactured in the 
normal way.



Page 24 CNC  MILLING / ROUTING TRAINING GUIDEPage 24 Page 25CNC MILLING / ROUTING TRAINING GUIDE

PCB manufacturing
Gerber format (RS-274X) is an industrial standard transfer fi le for defi ning circuit board 
tracks and pads.
VR CNC Milling has the facility to open Gerber data (version 5.10 onwards). When Gerber 
fi les are opened in VR CNC Milling, a wizard is launched which guides the user through 
some simple steps in order to manufacture the PCB.
The following tutorial gives an explanation of the steps involved in manufacturing a Gerber 
fi le using Denford VR CNC Milling.
Creating a Gerber fi le
Many PCB design softwares will create a Gerber fi le. The process of creating the Gerber 
fi le will vary between PCB design software, see the help of the individual software for more 
details. 'PCB Wizard' and 'Crocodile Clips - Real PCB' will both create Gerber fi les.
This tutorial shows the process of creating a Gerber fi le from PCB Wizard.
Exporting a fi le from PCB Wizard
In this section we will cover the settings required to export a Gerber fi le from PCB Wizard to 
make it suitable for manufacture on a CNC machine.
We will use the fi rst sample circuit contained in the software as an example. 
Open PCB Wizard.
The getting started Wizard will appear: 
Select Open Sample Circuits:

Select the 555 Astable.pcb fi le:
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Click “Open”
The standard PCB Wizard screen below is displayed.

The PCB tracking shown has a large ground 
plain or fl ood fi ll area. This is inserted 
automatically by PCB Wizard and has to be 
removed before exporting the gerber fi le to 
be manufactured. 

Tip - choose to view “Artwork” by selecting the button 
down the left hand side of the application 

In the example fi les in PCB wizard the 
documents are locked and cannot be edited.
To be able to remove the ground plain it is 
necessary to unprotect the document. To 
do this, select the “File” menu. Then select 
“Unprotect Document” 

Now select the ground plain on the tracked 
PCB. Right Click the Mouse to get the 
function menu. 
If all the options are greyed out then the 
document is protected.
Select “Delete”.
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All that is now left is the track layout and identifying 
text label.

Machining around the text will be a problem and will 
probably produce errors so you may wish to remove 
the text as well.
If you want to remove the Text simply select it then 
Right click the mouse then Select “Delete”.

The circuit is now in a format where it can be 
exported as a Gerber fi le for manufacture.
Gerber format (RS-274X) is an industrial standard 
transfer fi le for defi ning circuit board tracks and 
pads.
Select the “Tools” menu then “CAD/CAM” and fi nally 
“Export Gerber” output:

The following selections (as shown in image, right) 
should be made.
Check the following:
Circuit Board
Solder Side
Drill Holes
Place each layer in a separate output fi le
Drill Holes
Include Aperture table
Uncheck the following:
Plot Pads Only
Fill Drill Holes
Select “OK”.
The fi les are automatically created and placed into 
the folder specifi ed.

This will then open a sub menu where it is possible to defi ne which layers and information 
you wish to output. In this case we only have a Bottom Copper layer. The Export Gerber 
menu is shown:
Select the ”Save As” option after File Name. This allows you to defi ne where the gerber fi les 
will be saved. Create a folder and note where it is located. Name the fi le and click “Save”.
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Importing a Gerber File into VR Milling V5
Run the VR Milling V5 Software.
Select “File” “Open”.
Select the fi le types dropdown and select 
“Gerber Files (*.gb*)”
Select the “555 Astable.gb0” fi le
Select “Open”
The Gerber Import Wizard opens as shown:

The origin is drawn in the bottom left corner 
of the PCB but the top right extreme is 
defi ned by the last used PCB size.
Press “Auto Size” to set the board size to 
match the extents of the PCB tracks.

If you know the size the board was 
designed at type the values into the width 
and height boxes.
In this case the board is defi ned as 61mm 
x 61mm in size.

As you change the values the board shown 
will also change in size.
The fi rst layer imported is useful as it 
defi nes the board size but we do not want 
to machine this.

Defi ne Board

Close the Wizard (Cross at top right hand 
corner) and select “File” “Open” once again.
Select the “555Astable.gb1”. This is the 
bottom copper fi le. Select Open.
The bottom copper artwork is opened in the 
Wizard as shown.
The Width and Height values should have 
been remembered from last time, setting the 
board size to: 61mm x 61mm.
Click “Next”.

Tip: The image can be manipulated with the mouse. In the display window “Left click” the mouse and drag will 
rotate the image. Right Click and drag will zoom into the image. Left and Right together will 'pan' the image.
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Select Side
With most PCB design packages the view 
of the board is from the component side 
looking downward. By default the gerber 
fi le is also done this way. The bottom side 
or Solder side will be a mirror image of this 
when the board is turned over.

Select “Solder Side” and the image will 
mirror from left to right as shown:
The view is now shown as it will look when 
machined.
Note: For double-sided boards the 
component side does not need to be 
mirrored.
Select “Next”.

Generate Toolpath
To be able to generate the toolpath you need to defi ne the depth you want to cut to (making 
sure you cut right through the copper) and the diameter of the cutter you are going to use 
(to ensure it can get between the pads and tracks).
A typical depth to use would be 0.3mm as this will machine through the copper and into the 
board behind. It is also deep enough to take out some error if the board was not fl at while 
machining.
The standard engraving cutter Denford 
recommend is a 0.25mm tip with a 30-degree 
angle. Cutting at 0.3mm deep will leave a 
groove about 0.4mm wide.
Set the Cutting depth the 0.3mm
Set the Cutter Diameter to 0.4mm
Select “Calculate”

The cutter path around the tracks is calculated and displayed offset by half the diameter so 
in this case 0.2mm outside the tracks.
If the red warning banner appears then there is a problem somewhere in the design and the 
cutter cannot pass between all the tracks.
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Using the Zoom and Pan tool (via mouse 
buttons) you can inspect the tool cutter path 
and search for the error. If an error is found 
due to the tracks being too close together 
then you will need to modify your PCB 
design or fi nd a narrower cutter.

In this design there are no problems with 
the tracks but it is the text that is the 
problem. As the text is treated as a copper 
track if the tool cannot pass between the 
letters it will show as a possible error.
As you can see in the picture the tool path 
is unable to profi le round the text and as 
a result the fi le has warned there could be 
an error.Removing the text from the PCB 
before exporting would prevent the error 
occurring.
 
In the example shown here the tool width 
has been set to 0.7mm and the new 
toolpath calculated. The software will not 
allow the tool to pass through a gap that is 
too small as it would machine away copper 
that is required to make a connection. The 
resulting tool path would leave all the pads 
on the IC Base connected together.

Note also, that a pad with a hole in the 
center will produce this same error, if the 
tool diameter is too big to cut inside the hole, 
see image right.
Once you are happy there is no problem 
machining the Tracks and Pads click “Next”.

Tip: Care must be taken to ensure large enough 
isolation gaps were designed into the PCB before 
exporting as a gerber fi le.
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Drilling Operations

There are two options available to you when 
drilling a circuit board. Provided the Check 
Box: “Fill Drill Holes” was unchecked when 
the fi les were exported the pad information 
includes the internal hole sizes and the 
external pad diameter. As a result the Wizard 
can automatically calculate the number of 
different sized holes in the board and allocate 
a drill of that correct diameter to each hole.
Here the Auto Drill setting is selected and the 
Wizard has selected two drill sizes to be used.

The second method of drilling a PCB is to 
import the drill fi le.
To do this click on the “Read Drill File” button.
Locate the fi le 555 Astable.drl and “Open”.

This time the drill centres are shown with a default drill diameter. Again the two different 
sizes of drill are shown but the correct diameters are not given.
In this instance you have to read the “ini or report” fi le to fi nd the diameters of the drills 
required and ensure they are fi tted when the tool number is requested.
All drilling operations that are grouped by tool size, can be overridden and all drilled with 
the same tool. To do this, check the box “Pilot Drill Only” and select the drilling tool number. 
Doing this will cause all holes (that are turned on) to be drilled with the one tool, in effect 
pilot dilling them for opening out later. 
Select “Next”.

Speeds and Feeds
A default spindle speed and tool feedrate is allocated to each tool used in the program.
These feeds are the suggested values Denford recommend but each one can be 
customised as required.
Once the values are approved, select “Next”.
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It is possible to output the CNC code to cut the following 
combinations:

CNC Output

The tracks only
Drilling the holes only
Spot drilling only (to the same depth as the 
track cut depth, using the track cutter tool)
or, any combination of the above.
It may be that you want to just output the track outline and then drill the board later on a 
pillar drill, if so uncheck the “Output drilling operation” as shown.
If you want the drill output recheck the box.

Click [Create CNC]

The Wizard software will close and re-launch VR 
Milling 5. The newly created toolpath is loaded into the 
current editor.
The example shown shows the fi le loaded into the full 
editor with colour formatting on:
The section at the start of the program (program 
header) has comments within brackets. 
These comments tell you about the program, how 
it was created. They also includes information on 
the tools to be used, track side to be machined and 
a warning if there were isolation problems while 
processing.

The fast editor should be used for manufacture and is shown below:

The program is now ready to be manufactured in the normal way.


